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Introduction
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How to Use the Manual

This explains things that you need to know in order to use this manual.

 Notations Used in the Manual(P. 4)
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Notations Used in the Manual

This explains symbols and settings used in this manual.

Symbols Used in This Manual

In this manual, explanations of items and operations that must be followed while using the driver are set forth
the symbols that indicate the following.

 IMPORTANT

● Indicates operational requirements and restrictions. Be sure to read these items carefully to operate the
product correctly, and avoid damage to the product.

 NOTE

● Indicates a clarification of an operation, or contains additional explanations for a procedure. Reading these
notes is highly recommended.

About Settings

In this manual, setting names displayed on the computer screen are represented as shown in the following
examples.

Example:
[Settings]

[OK]
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Disclaimers

The information in this document is subject to change without notice.

CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, EITHER EXPRESS OR
IMPLIED, EXCEPT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO
MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OF USE OR NON-INFRINGEMENT.
CANON INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY
NATURE, OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.
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Copyright

Copyright CANON INC. 2025

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any language or computer language in any form or by any means, electronic, mechanical,
magnetic, optical, chemical, manual, or otherwise, without the prior written permission of Canon Inc.
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Trademarks

Apple, macOS, and Safari are trademarks of Apple Inc.

All brand names and product names appearing on this document are registered trademarks or trademarks of
their respective owners.

All other trademarks are the property of their respective owners.
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Before Use

● The newest driver software is posted on the Canon website. Please verify the operating environment etc. and
download the appropriate software as required.

Canon Global Site: https://global.canon/

● The functions that you can use may vary according to the following conditions.

- The device you are using and its settings

- The firmware version of the device

- The option structure of the device

- The driver version

- The computer environment you are using

- The application you are using

● The screen content, procedures, etc. displayed and described in the manual may differ from those actually
displayed.

● In this manual, examples using macOS 14 (Sonoma) are explained.
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Installing the Driver

This section explains driver installation and device preparation.

 Flow of Preparations for Faxing(P. 12)
 Pre-installation Check(P. 13)
 Installing the Driver(P. 16)
 Registering a Fax(P. 17)
 Uninstalling a Driver(P. 36)
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Flow of Preparations for Faxing

This driver is a macOS fax driver for Canon devices.

It can be used to directly send faxes from a computer without printing the images and documents, etc. created
in applications.

Before using the driver and sending faxes, there are preparations that need to be done beforehand.

Carry out preparations and settings in the following order.
1. Obtain an installer by one of the following methods.

- Download it from the Canon website (https://global.canon/)

- Supplied CD-ROM

2. Install the driver to macOS.

3. Register the fax you want to use to macOS.

4. Set the device options as necessary.

 NOTE

● You can check the version of the currently installed fax driver by clicking [General Settings] after clicking
[Printer Options] in the [Print] dialog.

Related Topics
 Installing the Driver(P. 16)
 Registering a Fax Connected by TCP/IP(P. 18)
 Registering a Fax Connected by USB(P. 24)
 Registering a Fax Connected by Bonjour(P. 30)
 Enabling Automatic Setting of the Options of the Device(P. 53)
 Manually Setting the Options of the Device(P. 56)
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Pre-installation Check

This describes the items to be checked beforehand in order to install the driver correctly.

 System Requirements(P. 14)
 About the Readme File(P. 15)

Installing the Driver
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System Requirements

Use one of the following system environments with this driver.

Operating Systems

macOS 10.15.7 or later

Hardware

A computer guaranteed to operate using the above operating system.

Installing the Driver
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About the Readme File

The Readme file contains information such as limitations, restrictions, and cautions when installing or using the
driver.

Refer to README-ENG.html in the accompanying CD-ROM or the downloaded driver folder.
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Installing the Driver

This section explains the procedure for installing the driver to macOS.

Install the driver and register the fax to use.

Prerequisites
● Obtain the driver installer.

● System Requirements(P. 14)

● Close all running applications.

● If the computer and device are connected by USB, turn off the main power of the device.

Procedures

1 Open the driver installer folder → select [Canon_FAX_Installer.pkg] or
[Canon_Driver.pkg].

2 Read the Software License Agreement → click [Continue].

If a dialog asking you to confirm that you agree to the Software License Agreement is displayed, click [Agree].

3 Click [Install].

If a dialog for entering a user name and/or password is displayed, enter the name and password of a
computer administrator and continue according to the instructions in the dialog.

If a caution message regarding loading of the software is displayed, agree with the message to complete the
installation.

4 Click [Close].

Register the fax.

Related Topics
 Flow of Preparations for Faxing(P. 12)
 Registering a Fax Connected by TCP/IP(P. 18)
 Registering a Fax Connected by USB(P. 24)
 Registering a Fax Connected by Bonjour(P. 30)
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Registering a Fax

Register the fax you are going to use.

Select a registration method according to the method by which the computer and fax are connected.

 Registering a Fax Connected by TCP/IP(P. 18)
 Registering a Fax Connected by USB(P. 24)
 Registering a Fax Connected by Bonjour(P. 30)
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Registering a Fax Connected by TCP/IP

You can register a fax connected by "Line Printer Daemon – LPD" in macOS.

Prerequisites
● System Requirements(P. 14)

● Installing the Driver(P. 16)

● Confirmation of specified IP address

If you do not know the IP address, check with the network administrator.

 NOTE

● If "Internet Printing Protocol - IPP" is usable, only IPv4 is supported.

Procedures

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Click [Add Printer, Scanner, or Fax].

Installing the Driver
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3 Select [  IP] in the toolbar → select [Line Printer Daemon – LPD] from [Protocol].

Installing the Driver
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4 Enter the IP address of the fax in [Address] → select [Select Software] from [Use].

If the driver corresponding to the fax is displayed in [Use], proceed to step 6.(P. 22) .

Installing the Driver

20



 NOTE

● A message indicating that the IP address is incorrect may be displayed even if the correct IP address has
been entered.

5 Enter the number included in the model name of the fax in the search field → select
the corresponding driver in the search results → click [OK].
For example, if the model name is "imageRUNNER ADVANCE DX 6870", enter "6870" and select "Canon iR-ADV
6860/6870 FAX" in the search results.

 NOTE

● Select a driver with a name starting with "Canon".

● If a driver matching the model name is not displayed in the search results, try the following:

- Try removing the last digit. For example, if the model name is "MF542", enter "54", and select the driver
that matches the model name with the last digit removed, such as "Canon MF540 Series FAX", in the
search results.

- If the corresponding driver is not displayed with the above method, try removing the last two digits. For
example, if the model name is "MF9220", enter "92", and select the driver that matches the model name
with the last two digits removed, such as "Canon MF9200 Series FAX".

● Drivers with the name "***** JP" are drivers for Japan. For other regions, select a driver that does not include
"JP" in its name.

● If the corresponding driver is not displayed with the above method, select the driver corresponding to the
model as follows:

- imageRUNNER C3020 Series/C3025 Series:

Canon iR C3000 Series FAX

- imageRUNNER ADVANCE C250 Series/C350 Series/C2020 Series/C2025 Series/C2030 Series/C2220 Series/
C2225 Series/C2230 Series/C5030 Series/C5035 Series/C5045 Series/C5051 Series/C5235 Series/C5240
Series/C5250 Series/C5255 Series/C7260 Series/C7270 Series/C351/C2218/C7055/C7065/C7280/C9060/
C9065/C9070/C9075/C9270/C9280:

Canon iR-ADV C Series FAX

- imageRUNNER ADVANCE 400 Series/500 Series/4025 Series/4035 Series/4045 Series/4051 Series/4225
Series/4235 Series/4245 Series/4251 Series/6055 Series/6065 Series/6075 Series/6255 Series/6265 Series/
6275 Series/8085 Series/8095 Series/8105 Series/8205 Series/8285 Series/8295 Series:

Canon iR-ADV Series FAX

- Color imageRUNNER C2880 Series/C3080 Series/C3380 Series/C3480 Series/C4080 Series/C4580 Series/
C5180 Series/C5185 Series/C2550:
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Canon iR C Series FAX

- imageRUNNER C3170/C5058/C5068/C5870/C6870:

Canon iR C Series FAX

- iR 2570C Series/3170C Series/3180C Series/5870C Series/5880C Series/6870C Series/6880C Series/C2550
Series/C2570 Series/C2880 Series/C3080 Series/C3170 Series/C3380 Series/C3580 Series/C3880 Series/
C4080 Series/C4580 Series/C5180 Series/C5185 Series/C5870 Series/C5880 Series/C6870 Series/C6880
Series/C2380/C2580/C3180:

Canon iR C Series FAX

- imagePRESS C1/C1+:

Canon iPR C Series FAX

- imageRUNNER 2230 Series/3235 Series/3245 Series/3530 Series/5050 Series/
2830/3025/3030/3035/3045/3225/3230/5055/5065/5075/5570/6570:

Canon iR Series FAX

- iR2230 Series/3025 Series/3030 Series/3035 Series/3045 Series/3225 Series/3230 Series/3235 Series/3245
Series/5055 Series/5065 Series/5075 Series/5570 Series/6570 Series/2830/3530/4530/5050:

Canon iR Series FAX

6 Change [Name] for the fax as necessary → click [Add].

7 Check that the registered fax is displayed in the [Printers] list.

Set the device options as necessary.

Installing the Driver
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Related Topics
 Flow of Preparations for Faxing(P. 12)
 Enabling Automatic Setting of the Options of the Device(P. 53)
 Manually Setting the Options of the Device(P. 56)
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Registering a Fax Connected by USB

You can register a fax connected by USB in macOS.

Prerequisites
● System Requirements(P. 14)

● Installing the Driver(P. 16)

● Installation of the optional USB interface board (if required with the fax you are using)

Procedures

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Turn the fax on → connect the fax and the computer by USB cable.

3 Check that the connected fax is displayed in the [Printers] list of the displayed dialog.

When using a device via a USB connection in macOS 10.15.x or earlier, macOS may block loading of the driver
and prevent fax transmission, depending on the model of the device. If so, click the subsequent "Open
details."

1. Display the [System Preferences] dialog of macOS → click [Security & Privacy].

2. Click [Allow] displayed on the [General] panel.

If the connected fax is not displayed, perform the following procedure.

4 Click [Add Printer, Scanner, or Fax].

Installing the Driver
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5 Select [ Default] in the toolbar → select a fax from the list.

Select a fax displayed as "USB" in [Kind].

Installing the Driver
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6 Select [Select Software] from [Use].
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7 Enter the number included in the model name of the fax in the search field → select
the corresponding driver in the search results → click [OK].
For example, if the model name is "imageRUNNER ADVANCE DX 6870", enter "6870" and select "Canon iR-ADV
6860/6870 FAX" in the search results.

 NOTE

● Select a driver with a name starting with "Canon".

● If a driver matching the model name is not displayed in the search results, try the following:

- Try removing the last digit. For example, if the model name is "MF542", enter "54", and select the driver
that matches the model name with the last digit removed, such as "Canon MF540 Series FAX", in the
search results.

- If the corresponding driver is not displayed with the above method, try removing the last two digits. For
example, if the model name is "MF9220", enter "92", and select the driver that matches the model name
with the last two digits removed, such as "Canon MF9200 Series FAX".

● Drivers with the name "***** JP" are drivers for Japan. For other regions, select a driver that does not include
"JP" in its name.

● If the corresponding driver is not displayed with the above method, select the driver corresponding to the
model as follows:

- imageRUNNER C3020 Series/C3025 Series:

Canon iR C3000 Series FAX

- imageRUNNER ADVANCE C250 Series/C350 Series/C2020 Series/C2025 Series/C2030 Series/C2220 Series/
C2225 Series/C2230 Series/C5030 Series/C5035 Series/C5045 Series/C5051 Series/C5235 Series/C5240
Series/C5250 Series/C5255 Series/C7260 Series/C7270 Series/C351/C2218/C7055/C7065/C7280/C9060/
C9065/C9070/C9075/C9270/C9280:

Canon iR-ADV C Series FAX

- imageRUNNER ADVANCE 400 Series/500 Series/4025 Series/4035 Series/4045 Series/4051 Series/4225
Series/4235 Series/4245 Series/4251 Series/6055 Series/6065 Series/6075 Series/6255 Series/6265 Series/
6275 Series/8085 Series/8095 Series/8105 Series/8205 Series/8285 Series/8295 Series:

Canon iR-ADV Series FAX

- Color imageRUNNER C2880 Series/C3080 Series/C3380 Series/C3480 Series/C4080 Series/C4580 Series/
C5180 Series/C5185 Series/C2550:

Canon iR C Series FAX

- imageRUNNER C3170/C5058/C5068/C5870/C6870:

Canon iR C Series FAX
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- iR 2570C Series/3170C Series/3180C Series/5870C Series/5880C Series/6870C Series/6880C Series/C2550
Series/C2570 Series/C2880 Series/C3080 Series/C3170 Series/C3380 Series/C3580 Series/C3880 Series/
C4080 Series/C4580 Series/C5180 Series/C5185 Series/C5870 Series/C5880 Series/C6870 Series/C6880
Series/C2380/C2580/C3180:

Canon iR C Series FAX

- imagePRESS C1/C1+:

Canon iPR C Series FAX

- imageRUNNER 2230 Series/3235 Series/3245 Series/3530 Series/5050 Series/
2830/3025/3030/3035/3045/3225/3230/5055/5065/5075/5570/6570:

Canon iR Series FAX

- iR2230 Series/3025 Series/3030 Series/3035 Series/3045 Series/3225 Series/3230 Series/3235 Series/3245
Series/5055 Series/5065 Series/5075 Series/5570 Series/6570 Series/2830/3530/4530/5050:

Canon iR Series FAX

8 Change [Name] for the fax as necessary → click [Add].

9 Check that the registered fax is displayed in the [Printers] list.

Set the device options as necessary.

Related Topics
 Flow of Preparations for Faxing(P. 12)
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 Enabling Automatic Setting of the Options of the Device(P. 53)
 Manually Setting the Options of the Device(P. 56)

Installing the Driver

29



Registering a Fax Connected by Bonjour

You can register a fax connected by Bonjour to macOS.

 NOTE

● Some fax models are not compatible with Bonjour connections.

Prerequisites
● System Requirements(P. 14)

● Installing the Driver(P. 16)

Procedures

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Click [Add Printer, Scanner, or Fax].
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3 Select [ Default] in the toolbar → select a fax from the list.

Select a fax displayed as "Bonjour" in [Kind].

If the corresponding driver is already registered in [Use] in the displayed dialog, proceed to step 7.(P. 34) .

Installing the Driver
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4 Select [Select Software] from [Use].
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5 Enter the number included in the model name of the fax in the search field → select
the corresponding driver in the search results → click [OK].
For example, if the model name is "imageRUNNER ADVANCE DX 6870", enter "6870" and select "Canon iR-ADV
6860/6870 FAX" in the search results.

 NOTE

● Select a driver with a name starting with "Canon".

● If a driver matching the model name is not displayed in the search results, try the following:

- Try removing the last digit. For example, if the model name is "MF542", enter "54", and select the driver
that matches the model name with the last digit removed, such as "Canon MF540 Series FAX", in the
search results.

- If the corresponding driver is not displayed with the above method, try removing the last two digits. For
example, if the model name is "MF9220", enter "92", and select the driver that matches the model name
with the last two digits removed, such as "Canon MF9200 Series FAX".

● Drivers with the name "***** JP" are drivers for Japan. For other regions, select a driver that does not include
"JP" in its name.

● If the corresponding driver is not displayed with the above method, select the driver corresponding to the
model as follows:

- imageRUNNER C3020 Series/C3025 Series:

Canon iR C3000 Series FAX

- imageRUNNER ADVANCE C250 Series/C350 Series/C2020 Series/C2025 Series/C2030 Series/C2220 Series/
C2225 Series/C2230 Series/C5030 Series/C5035 Series/C5045 Series/C5051 Series/C5235 Series/C5240
Series/C5250 Series/C5255 Series/C7260 Series/C7270 Series/C351/C2218/C7055/C7065/C7280/C9060/
C9065/C9070/C9075/C9270/C9280:

Canon iR-ADV C Series FAX

- imageRUNNER ADVANCE 400 Series/500 Series/4025 Series/4035 Series/4045 Series/4051 Series/4225
Series/4235 Series/4245 Series/4251 Series/6055 Series/6065 Series/6075 Series/6255 Series/6265 Series/
6275 Series/8085 Series/8095 Series/8105 Series/8205 Series/8285 Series/8295 Series:

Canon iR-ADV Series FAX

- Color imageRUNNER C2880 Series/C3080 Series/C3380 Series/C3480 Series/C4080 Series/C4580 Series/
C5180 Series/C5185 Series/C2550:

Canon iR C Series FAX

- imageRUNNER C3170/C5058/C5068/C5870/C6870:

Canon iR C Series FAX
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- iR 2570C Series/3170C Series/3180C Series/5870C Series/5880C Series/6870C Series/6880C Series/C2550
Series/C2570 Series/C2880 Series/C3080 Series/C3170 Series/C3380 Series/C3580 Series/C3880 Series/
C4080 Series/C4580 Series/C5180 Series/C5185 Series/C5870 Series/C5880 Series/C6870 Series/C6880
Series/C2380/C2580/C3180:

Canon iR C Series FAX

- imagePRESS C1/C1+:

Canon iPR C Series FAX

- imageRUNNER 2230 Series/3235 Series/3245 Series/3530 Series/5050 Series/
2830/3025/3030/3035/3045/3225/3230/5055/5065/5075/5570/6570:

Canon iR Series FAX

- iR2230 Series/3025 Series/3030 Series/3035 Series/3045 Series/3225 Series/3230 Series/3235 Series/3245
Series/5055 Series/5065 Series/5075 Series/5570 Series/6570 Series/2830/3530/4530/5050:

Canon iR Series FAX

6 Change [Name] for the fax as necessary → click [Add].

7 Check that the registered fax is displayed in the [Printers] list.

Set the device options as necessary.

 NOTE

● Fax transmission may fail when using a fax registered with a Bonjour connection. In this case, transmission
may be possible by registering the fax again with a TCP/IP connection.
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Related Topics
 Flow of Preparations for Faxing(P. 12)
 Registering a Fax Connected by TCP/IP(P. 18)
 Enabling Automatic Setting of the Options of the Device(P. 53)
 Manually Setting the Options of the Device(P. 56)
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Uninstalling a Driver

This explains the procedure for uninstalling a driver that is no longer needed.

Prerequisites
● When connected by USB, removal of the USB cable connecting the device and the computer

● Confirmation of the device name to be deleted

 NOTE

● The driver can be upgraded. It is not necessary to uninstall the old driver.

Procedures

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Select the device to uninstall.

3 In the displayed dialog, click [Remove Printer].
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4 Delete the files of the driver to uninstall in the [Library] folder of macOS.

If a confirmation dialog is displayed, enter an administrator name and password and click [OK].

The name represented by "****" varies according to the device.

- Library/Printers/Canon/CUPSFAX

- Library/Printers/PPDs/Contents/Resources/CNMC****F.ppd.gz

- Library/Printers/PPDs/Contents/Resources/CNMC****FB.ppd.gz

- Library/Extensions/CanonCUPSFAXUSBClassDriver.kext

- usr/libexec/cups/backend/canonoipnetf

5 Restart macOS.

Installing the Driver
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Fax Sending

 Sending a Fax from an Application(P. 40)
 Editing the Address Book(P. 43)
 Attaching a Cover Sheet(P. 46)
 Arranging Multiple Pages on One Sheet of Paper(P. 47)
 Registering Presets(P. 48)
 Setting User Information from FAX Utility(P. 49)
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Sending a Fax from an Application

This section explains the basic procedure for sending a fax from an application.

1 Select [Print] from the application's [File] menu.

2 In the [Print] dialog, select the device to use from the [Printer] pop-up menu.

3 Configure the fax sending options.

Fax Sending
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To use settings saved as a preset

Select the name of the preset from the [Presets] pop-up menu.

To configure the fax function of the device

Click [Printer Options] → configure the required items.

Fax Sending
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4 Specify a destination.

To enter a new address

(1) Click [General Settings].

(2) Click [Add Destination].

(3) In the displayed dialog, enter the fax number in [Fax Number] → click [Add] or [Add Destination].
Only [Fax Number] is required. Set the other items according to your needs.

(4) Click [OK].

To select an address from the address book

(1) Click [General Settings].
If a pop-up screen is displayed, allow access to macOS "Contacts".

(2) Click [Address Book].

(3) In the displayed dialog, select the destination → click [Add] or [Add Groups].
When adding a group as a destination, the numbers set as the highest priorities in [Edit] > [Edit Distribution
List] in macOS "Contacts" are displayed.

(4) Click [OK].

 NOTE

● The maximum number of destinations that a fax can be sent to differs according to the setting in [Cover
Sheet Attachment] of the [Cover Sheet] pane, as indicated below. When the following number of destinations
is exceeded, the job is divided into multiple jobs for sending. Therefore, the job may be displayed as multiple
jobs in the fax sending history, etc.

- When [Cover Sheet Attachment] is set to [None]: 256 destinations

- When [Cover Sheet Attachment] is set to [Different Sheet to Each Destination]: 32 destinations

- When [Cover Sheet Attachment] is set to [Same Sheet to All Destinations]: 256 destinations

5 In the [Print] dialog, click [Print].

Related Topics
 Flow of Preparations for Faxing(P. 12)
 Registering Presets(P. 48)
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Editing the Address Book

Fax Utility can be used to edit, import, and export the addresses registered in macOS "Contacts".

To add or edit an address book card

You can add an address card to the address book or edit a registered card.

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Select the device to use.

3 In the displayed dialog, click [Options & Supplies].

4 In the displayed dialog, click the [Utility] tab → click [Open Printer Utility].

Fax Utility starts.

If a pop-up screen is displayed, allow access to macOS "Contacts".

5 Click the [Address Book] tab.

6 Click [Add Card].

When editing a registered card, select the card → click [Edit Card].

7 In the displayed dialog, edit the items as required.

8 Click [OK].

To export an address book

You can export the contents of an address book using the FAX Utility.

You can import and use the saved file on another computer, a Windows version fax driver, or device.

 NOTE

● When exporting the address book, export it with v4.15.16 or later of this driver.

1 Start the FAX Utility → select [File] > [Address Book] > [Export] in the menu bar.
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2 In the displayed dialog, specify the location to save to, the file name, and format.

When saving with the "*.csv" extension, select [CSV].

When saving with the "*.abk (Canon Address Book)" extension, select [LDIF].

3 Click [Save].

If there is group information, a "group information file (*.gsv)" is also saved with the same name as the saved
file name.

If home and work destinations are both registered, the different destinations are saved in an extended LDIF
file.

To import an address book

You can use FAX Utility to import data to be used in an address book.

You can import the address book data on another computer, a Windows version fax driver, or device.

 NOTE

● Address book data exported with v4.15.15 or earlier of this driver may not be able to be imported correctly. If
that happens, update the driver to the latest version after importing the data with v4.15.15 or earlier of this
driver.

● When importing address book data exported from a Windows version fax driver or a device, import it with
v4.15.16 or later of this driver.

1 Start the FAX Utility → select [File] > [Address Book] > [Import] > [File] or [Address Book
of Fax Driver v3.70 or Earlier] in the menu bar.
If a dialog indicating that "The address book will be registered" is displayed, click [OK].

2 Select a file to be imported (with the extension "*.csv (comma separated)", "*.dcm", or
"*.abk").

 NOTE

● For group information files, if CSV files are present, they will be imported at the same time. Use file names so
that those parts without the extension (*.csv) match the CSV file. Also, when importing, place them in the
same folder as the CSV file.

● When importing an address book which is exported from a device, use a CSV file, ABK file, or DCM file
exported with security level 1.

You cannot import device setting information files (*.dcm) with all device settings exported from a device
with a security level other than security level 1 specified.

3 Click [Show Options] → select [Use primary number as home fax number] or [Use
primary number as work fax number] → click [Open].
When importing as a group, select [Import the selected file as a group] and enter [Group Name].

Device Address Books

The data of the address book registered on a device can be imported and used in the fax driver. An address
book edited in a computer can also be imported to a device.
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For details, refer to the manual of the device.

 NOTE

● When importing an address book exported with FAX Utility to a device, select the device to import to when
exporting the address book. Address book data exported for another device may not be able to be imported
correctly.

Related Topics
 Setting User Information from FAX Utility(P. 49)
 FAX Utility Settings(P. 67)
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Attaching a Cover Sheet

You can attach a prepared cover sheet in the driver to the document to be sent.

1 In the [Print] dialog, click [Printer Options] → click [Cover Sheet].

2 Select the attachment method from the [Cover Sheet Attachment] pop-up menu.

3 Select a template from the [Style] list.

4 If necessary, click [Item Settings].

5 In the displayed dialog, configure the required settings → click [OK].

6 Click [OK].

Related Topics
 [Cover Sheet] Pane(P. 66)
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Arranging Multiple Pages on One Sheet of Paper

This section explains the procedure for sending multiple pages on a single sheet of paper via fax.

Select the direction you want to arrange the pages in on the paper and print borders around the arranged
pages.

1 In the [Print] dialog, click [Printer Options] → click [Layout].

2 Select the number of pages to be arranged on each sheet of paper from the [Pages per
Sheet] pop-up menu.
For detailed settings such as the direction in which the pages are arranged, printing borders around each
page, etc., perform the following procedure.

3 Select what direction the pages are to be arranged in from [Layout Direction].

4 Select the type of border from the [Border] pop-up menu.
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Registering Presets

You can register frequently used settings in [Presets] and recall the settings when sending faxes.

You can also set a preset you use frequently so that it is displayed and immediately available next time you send
a fax.

1 In the [Print] dialog, select print options and set the functions to register as a preset.

2 Select [Save Current Settings as Preset] from [Presets].

3 Enter [Preset Name] → select [Available For].

4 In [Type], select [Print Job Preset] → click [OK].

[Print Job Preset] is the preset used for general fax jobs. To register a preset to use in combination with [Print
Job Preset], select [Custom Preset] in [Type].

When you frequently use a registered preset, select the preset and send a fax after executing the following
procedure. Next time you send a fax thereafter, it will be displayed in [Presets]. However, you need to specify a
destination each time you send a fax.

5 Select [Edit Preset List] from [Presets].

6  Deselect [Reset Presets Menu to "Default Settings" After Printing] → click [OK].
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Setting User Information from FAX Utility

You can set default settings relating to user information (PINs for department ID management and user
authentication, etc.) by using FAX Utility.

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Select the device to use.

3 In the displayed dialog, click [Options & Supplies].

4 In the displayed dialog, click the [Utility] tab → click [Open Printer Utility].

Fax Utility starts.

5 In FAX Utility, set the required items.

6 Click [Save Settings].

Related Topics
 FAX Utility Settings(P. 67)
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Linking the Driver and the Device

 Setting the Options of the Device(P. 52)
 Setting the Authentication Function(P. 58)
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Setting the Options of the Device

You can register, in the driver, the options (such as paper drawers and finishers) installed in the device, and set
the functions related to the options so that they can be used by the driver.

When using the device for the first time or adding options to the device, the option information must be
registered in the driver.

 Enabling Automatic Setting of the Options of the Device(P. 53)
 Manually Setting the Options of the Device(P. 56)
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Enabling Automatic Setting of the Options of the
Device

When using a device that supports bi-directional communication, you can set the computer to automatically
retrieve the option information of the device using the FAX Utility.

Prerequisites
● Installing the Driver(P. 16)

● Registering a Fax(P. 17)

● Confirmation that the device you are using is set to perform duplex communication

For information on the setting method, refer to the manual of the device.

Procedures

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Select the device to use.

3 In the displayed dialog, click [Options & Supplies].

4 In the displayed dialog, click the [Utility] tab → click [Open Printer Utility].

Fax Utility starts.
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5 Click [Printer Information] in the displayed FAX Utility dialog.

6 In the [Printer Information] dialog, check the device information → click [OK].
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 NOTE

● If the driver name displayed at the top of the [Printer Information] dialog and the name displayed in
[Configuration] > [Name Retrieved from Printer] do not match, you may not be able to use the functions of
the device. If this happens, delete the device from the [System Settings] of macOS and register the device
again.

Related Topics
 Flow of Preparations for Faxing(P. 12)
 Registering a Fax Connected by TCP/IP(P. 18)
 Registering a Fax Connected by USB(P. 24)
 Registering a Fax Connected by Bonjour(P. 30)
 Manually Setting the Options of the Device(P. 56)
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Manually Setting the Options of the Device

If the device is connected by uni-directional communication, the options of the device must be set manually.

Prerequisites
● Installing the Driver(P. 16)

● Registering a Fax(P. 17)

Procedures

1 Open [System Settings] in macOS → click [Printers & Scanners] in the sidebar.

2 Select the device to use.

3 In the displayed dialog, click [Options & Supplies].

4 In the displayed dialog, click the [Options] tab.
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5 Set the options of the device → click [OK].

 NOTE

● Select only the options that are actually installed in the device.

● For information on operating the device, check the manual of the device.

Related Topics
 Flow of Preparations for Faxing(P. 12)
 Registering a Fax Connected by TCP/IP(P. 18)
 Registering a Fax Connected by USB(P. 24)
 Registering a Fax Connected by Bonjour(P. 30)
 Enabling Automatic Setting of the Options of the Device(P. 53)
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Setting the Authentication Function

You can perform fax management by means of the department ID management function or the user
authentication function.

Department ID Management

You can perform authentication management for groups using department IDs and PINs.

1 In the [Print] dialog, click [Printer Options] → click [Special Features] or [Advanced
Settings].

2 In the displayed pane, select the Department ID Management function.

If [User Management] is displayed in the [Special Features] pane
(1) Select [Department ID Management] from the [User Management] pop-up menu → click [Settings].

(2) In the displayed dialog, set [Department ID] and [PIN] → click [OK].

If [Use Department ID Management] is displayed in the [Special Features] pane
(1) Select [Use Department ID Management] → click [Settings].

(2) In the displayed dialog, set [Department ID] and [PIN] → click [OK].

For the [Advanced Settings] pane
(1) Click the [Authentication] tab → select [Use Department ID Management].

(2) Set [Department ID] and [PIN] → click [OK].

User Authentication Management

You can perform user authentication management using user names and passwords.

1 In the [Print] dialog, click [Printer Options] → click [Special Features].

2 Select [User Authentication] from the [User Management] pop-up menu → click
[Settings].

3 In the displayed dialog, enter [User Name] and [Password] → click [OK].

Related Topics
 [Advanced Settings] Pane(P. 63)
 [Special Features] Pane(P. 64)
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Settings List

 [General Settings] Pane(P. 61)
 [Advanced Settings] Pane(P. 63)
 [Special Features] Pane(P. 64)
 [Cover Sheet] Pane(P. 66)
 FAX Utility Settings(P. 67)
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[General Settings] Pane

You can set send destinations, send schedules, etc.

[Destination List]

Destinations specified for sending faxes are displayed in list form.

[Add Destination]

Adds a new destination.

[Destination Name]
Enter a destination name.

[Communication Mode]
Sets the mode to use for communication.

[Fax Number/URI]
Select whether to enter the fax number of the destination or enter a URI.

[Fax Number]/[URI]
Enter a fax number or URI according to the [Fax Number/URI] selection.

[Advanced Function]
Set this when using the subaddress function (function that adds a PIN) or the ISDN subaddress function
(function that adds a supplementary extension number).

[Address Book]

Select a destination from the address book. To use this function, you need to allow the application you are using
to access macOS "Contacts".

[Edit Destination]

Edits the destination selected in [Destination List].

[Delete]

Deletes the destination selected in [Destination List].

[Number of Destinations]

Displays the specified number of destinations.

[Set the Time to Send]

Specifies a send time. The send data is temporarily saved in the device, then sent at the specified time.

Related Topics
 Sending a Fax from an Application(P. 40)

Settings List

61



 Editing the Address Book(P. 43)
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[Advanced Settings] Pane

You can set the resolution, authentication function, etc. of the fax to be sent.

[Resolution]

Selects a resolution for the fax data to be sent.

[Line]

Specifies the phone line and outside line number for sending faxes.

[Specify Outside Dialing Prefix]
Use this when an outside line number is required.

[Select Line]
If there are multiple phone lines, select the line to be used for sending.

[Authentication]

Sets a department ID and PIN for managing fax transmissions.

[Use Department ID Management]
You can manage the fax transmission status for each registered department ID.

Related Topics
 Sending a Fax from an Application(P. 40)
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[Special Features] Pane

You can set such management methods as sender settings and user authentication.

[Resolution]

Selects the resolution.

[Outside Dialing Prefix]/[Add Outside Dialing Prefix to G3/G4/IP Fax Number]

Use this when an outside line number is required. Enter an outline line number according to the communication
mode in [Settings].

Outside line numbers are not set for destinations that specify a URI.

[Select Line]

Selects the line to use. You can change the name of the line to a desired name in [Customize Line Name].

[Sender]

The specified sender name is displayed in the fax header. Changes this to a desired name in [Settings].

[Use Department ID Management]

Manages the fax transmission status for each registered department ID. Click [Settings] to set details.

[User Management]

Selects a management function to set. Set [Department ID Management] or [User Authentication].

[Reenter Fax Number Before Adding Destination to [Destination List]]/[Reenter Fax
Number/URI Before Adding Destination to [Destination List]]

Displays the [Confirm Destination] dialog when adding a new destination in the [General Settings] panel. By re-
entering the fax number or URI, erroneous input is prevented.

[Job Done Notice]

Select [Settings] and specify the detailed settings to notify the specified e-mail address of the fax send result.

☞ [Job Done Notice Settings] Dialog

[Job Done Notice]
Set this to notify an e-mail address of the fax send result. You can also set to only notify for errors.

Error notifications are limited to errors that occur between the device and the destination fax.

Notifications are not given for errors that occur between the computer and the device, even if [Errors Only] is
selected.

To confirm whether a fax has been sent correctly, check the fax transmission log or print queue at the device,
and check the transmission result between the computer and the device.

[E-Mail Address for Notification]
Enter the e-mail address to notify of job completion.
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Related Topics
 Sending a Fax from an Application(P. 40)
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[Cover Sheet] Pane

You can set the content of the cover sheet attached to the fax transmission data.

[Cover Sheet Attachment]

Selects whether to attach a cover sheet.

[Different Sheet to Each Destination]
Attaches a cover sheet for each destination.

[Same Sheet to All Destinations]
Attaches the same cover sheet for all destinations.

[Item Settings]

Sets items to be displayed on the cover sheet.

[Labels and Comments]
Sets labels or comments for the included items.

[Insert Attention Note]
Attaches a label, such as "Urgent," "Confidential," etc. Select a label from the list in [Attention Note] or enter
desired text.

[Comment to Include]
Enter a comment if necessary.

[Sender]
Select the items to describe the sender and enter a description in each.

[Destination]
Specifies the items to be displayed on the cover sheet.

[Details]
Displays the number of pages being sent, the subject name, etc. in the cover sheet.

[Style]

Selects a cover sheet template.

Related Topics
 Sending a Fax from an Application(P. 40)
 Editing the Address Book(P. 43)
 Attaching a Cover Sheet(P. 46)
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FAX Utility Settings

You can sets the initial values to use for the authentication function when sending faxes, etc. You can also add
or edit addresses in the address book.

[Printer Details] Pane

Sets the authentication function of the device. You can also check the information of the device you are using.

Common Items

This section describes the common items displayed in each dialog.

[Printer Name]
Displays the name of the target printer.

If the utility was started from [Printers & Scanners], the printer name of the selected device is displayed.

If the utility was started from "Finder", a list of the printer names of the devices registered in macOS is
displayed.

[Kind]
Displays the type of driver that is set.

If the utility was started from [Printers & Scanners], the driver name of the selected device is displayed.

If the utility was started from "Finder", a list of the driver names of the devices registered in macOS is
displayed.

[Printer Information]
Displays the settings of the options installed in the device.

When duplex communication is used and device information can be retrieved, the option settings are
displayed.

When simplex communication is used or information cannot be retrieved from the device, the option settings
manually specified in advanced are displayed.

[Remote UI]
Displays the Remote UI page of the selected device.

[Save Settings]
Saves the changed settings.

[Department ID Management] Pane

Set this to perform Department ID Management.

Enter the numbers set on the device in [Department ID] and [PIN]. If you select [Verify], you can check whether
the values you entered match the device settings.

[Authentication Function] Pane

Set this when using [Department ID Management] or [User Authentication].
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Enter the values set on the device in [Department ID] and [PIN] or [User Name] and [Password]. If you select
[Verify], you can check whether the values you entered match the device settings.

[User Information] Pane

Sets the user name to use when sending faxes. If you selected [Enter Name], enter an arbitrary name. The user
name you set is displayed on the control panel of the device and used when sending faxes.

[Display Settings] Pane

Displays a confirmation message when sending faxes.

[Job Done Notice] Pane

Set this to notify the specified e-mail address of the fax send result.

[Job Done Notice]
Set this to notify an e-mail address of the fax send result. You can also set to only notify for errors.

Error notifications are limited to errors that occur between the device and the destination fax.

Notifications are not given for errors that occur between the computer and the device, even if [Errors Only] is
selected.

To confirm whether a fax has been sent correctly, check the fax transmission log or print queue at the device,
and check the transmission result between the computer and the device.

[E-Mail Address for Notification]
Enter the e-mail address to notify of job completion.

[Address Book] Pane

Updates the address book of macOS.

[Add Card]

Adds a new address.

[Edit Card]

Changes the address that is registered.

Related Topics
 Enabling Automatic Setting of the Options of the Device(P. 53)
 Manually Setting the Options of the Device(P. 56)
 Editing the Address Book(P. 43)
 Setting the Authentication Function(P. 58)
 Setting User Information from FAX Utility(P. 49)

Settings List

68



Troubleshooting
Troubleshooting ...............................................................................................................................................  70

Cannot Register a Device Connected by Bonjour ..............................................................................................  71

Data Transmission to the Device Takes Too Long .............................................................................................  72

Cannot Select the Address Book on the [General Settings] Pane .....................................................................  73

Cannot Edit the Address Book in FAX Utility ...................................................................................................... 74

Cannot Retrieve Device Information in FAX Utility (macOS 15 or Later) .........................................................  75

Troubleshooting

69



Troubleshooting

This explains solutions to common problems.

Limitations and precautions are also included in the Readme file.

 Cannot Register a Device Connected by Bonjour(P. 71)
 Data Transmission to the Device Takes Too Long(P. 72)
 Cannot Select the Address Book on the [General Settings] Pane(P. 73)
 Cannot Edit the Address Book in FAX Utility(P. 74)
 Cannot Retrieve Device Information in FAX Utility (macOS 15 or Later)(P. 75)
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Cannot Register a Device Connected by Bonjour

When registering a device connected by Bonjour in macOS, the corresponding device may not be displayed in
the [Add Printer] dialog.

If this happens, it could be due to a number of causes. Change settings as necessary by referring to each
"Remedy."

Cause 1.

The settings of the device are incorrect

Remedy
Confirm that the Bonjour settings in the control panel of the device are enabled. For details, refer to the
manual of the device.

Cause 2.

The network settings of macOS are incorrect

Remedy
Check whether the necessary settings have been configured in the network settings of macOS. If they have not
been set, change the settings according to the following procedure.

(1) Open [System Settings] in macOS → click [Network] in the sidebar.

(2) Select [ ] > [Locations] > [Edit Locations], and configure the network environment.

(3) Click "Finder" in "Dock".

(4) Select [Finder] > [Settings] in the menu bar.

(5) Click the [General] tab in the [Finder Settings] dialog → select [Connected servers].

Cause 3.

The driver has not been installed correctly

Remedy
Reinstall the driver and register the device again.

Related Topics
 Installing the Driver(P. 16)
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Data Transmission to the Device Takes Too Long

If transmission takes a long time when sending data to the device, it could be caused by the following. Follow
the instructions described in "Remedy."

Cause

The amount of data being sent to the device is large, such as a document containing color photographs
or large images

Remedy
If the resolution is set higher than needed, change the resolution.

(1) In the [Print] dialog, click [Printer Options] → click [Special Features] or [Advanced Settings].

(2) Select the appropriate resolution from the [Resolution] pop-up menu.

Related Topics
 [Advanced Settings] Pane(P. 63)
 [Special Features] Pane(P. 64)
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Cannot Select the Address Book on the [General
Settings] Pane

If you cannot click [Address Book], it could be caused by the following. Follow the instructions in "Remedy."

Cause

Access to macOS "Contacts" may not be allowed for the application you are using

Remedy
Check the information displayed in [Contacts] in [System Settings] > [Privacy & Security] > [Privacy].

If the application you are using is displayed:
Allow access to "Contacts" for the application you are using.

(1) Open [System Settings] in macOS → click [Privacy & Security] in the sidebar.

(2) In [Privacy], select [Contacts].

(3) Turn on the application you are using.

If the application you are using is not displayed:
The application you are using cannot access macOS "Contacts".

To specify a destination from the address book, use another application, or convert the application data to a
PDF file and use a PDF viewer application other than "Preview".
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Cannot Edit the Address Book in FAX Utility

If you cannot edit the address book in FAX Utility, it could be caused by the following. Follow the instructions in
"Remedy."

Cause

Access to macOS "Contacts" may not be allowed for FAX Utility

Remedy
Allow access to "Contacts" for FAX Utility.

(1) Open [System Settings] in macOS → click [Privacy & Security] in the sidebar.

(2) In [Privacy], select [Contacts].

(3) Turn on [Canon FAX Utility].
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Cannot Retrieve Device Information in FAX Utility
(macOS 15 or Later)

If you cannot retrieve device information in FAX Utility, it could be caused by the following. Follow the
instructions in "Remedy."

Cause

FAX Utility is not allowed to search for devices on the local network

Remedy
Allow FAX Utility to search for devices on the local network.

(1) Open [System Settings] in macOS → click [Privacy & Security] in the sidebar.

(2) Select [Local Network].

(3) Turn on [Canon FAX Utility].
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This Font Software is licensed under the SIL Open Font License,
Version 1.1.

This license is copied below, and is also available with a FAQ at:
http://scripts.sil.org/OFL

-----------------------------------------------------------
SIL OPEN FONT LICENSE Version 1.1 - 26 February 2007
-----------------------------------------------------------

PREAMBLE
The goals of the Open Font License (OFL) are to stimulate worldwide
development of collaborative font projects, to support the font
creation efforts of academic and linguistic communities, and to
provide a free and open framework in which fonts may be shared and
improved in partnership with others.

The OFL allows the licensed fonts to be used, studied, modified and
redistributed freely as long as they are not sold by themselves. The
fonts, including any derivative works, can be bundled, embedded,
redistributed and/or sold with any software provided that any reserved
names are not used by derivative works. The fonts and derivatives,
however, cannot be released under any other type of license. The
requirement for fonts to remain under this license does not apply to
any document created using the fonts or their derivatives.

DEFINITIONS
"Font Software" refers to the set of files released by the Copyright
Holder(s) under this license and clearly marked as such. This may
include source files, build scripts and documentation.

"Reserved Font Name" refers to any names specified as such after the
copyright statement(s).

"Original Version" refers to the collection of Font Software
components as distributed by the Copyright Holder(s).

"Modified Version" refers to any derivative made by adding to,
deleting, or substituting -- in part or in whole -- any of the
components of the Original Version, by changing formats or by porting
the Font Software to a new environment.

"Author" refers to any designer, engineer, programmer, technical
writer or other person who contributed to the Font Software.

PERMISSION & CONDITIONS
Permission is hereby granted, free of charge, to any person obtaining
a copy of the Font Software, to use, study, copy, merge, embed,
modify, redistribute, and sell modified and unmodified copies of the
Font Software, subject to the following conditions:
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1) Neither the Font Software nor any of its individual components, in
Original or Modified Versions, may be sold by itself.

2) Original or Modified Versions of the Font Software may be bundled,
redistributed and/or sold with any software, provided that each copy
contains the above copyright notice and this license. These can be
included either as stand-alone text files, human-readable headers or
in the appropriate machine-readable metadata fields within text or
binary files as long as those fields can be easily viewed by the user.

3) No Modified Version of the Font Software may use the Reserved Font
Name(s) unless explicit written permission is granted by the
corresponding Copyright Holder. This restriction only applies to the
primary font name as presented to the users.

4) The name(s) of the Copyright Holder(s) or the Author(s) of the Font
Software shall not be used to promote, endorse or advertise any
Modified Version, except to acknowledge the contribution(s) of the
Copyright Holder(s) and the Author(s) or with their explicit written
permission.

5) The Font Software, modified or unmodified, in part or in whole,
must be distributed entirely under this license, and must not be
distributed under any other license. The requirement for fonts to
remain under this license does not apply to any document created using
the Font Software.

TERMINATION
This license becomes null and void if any of the above conditions are
not met.

DISCLAIMER
THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT
OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL THE
COPYRIGHT HOLDER BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL
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FROM, OUT OF THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM
OTHER DEALINGS IN THE FONT SOFTWARE.
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